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Chapter
5 Printing Documents and 

Diagrams
This chapter describes the different Print dialogs in Telelogic Tau 
and the printing differences between the Organizer, the SDL suite 
and the TTCN suite.

In the beginning of the chapter you can also find some introductory 
examples of how to print.
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General
You can print from virtually all Telelogic Tau tools that provide a 
graphical user interface. It is possible to print the information that is 
managed by an individual tool, such as a graphical editor or a viewer, 
or to print all (or parts of) information that is related to a document 
structure, from the Organizer.

Print Dialogs
You specify the print options in Print and Print Setup dialog. These di-
alogs have different appearances, depending on where they are invoked 
from – the Organizer, the TTCN suite or an SDL suite tool. The TTCN 
suite in Windows also provides a print preview.

Output Formats
The following output formats are provided:

• PostScript Output (including Encapsulated PostScript)
• FrameMaker Output
• Interleaf Output
• Web Files (HTML+PNG)
• MSWPrint Output (Windows only)
• Microsoft Word Output (Windows only)

When you print a TTCN document, only PostScript output is available. 
However, in the TTCN suite in Windows, it is also possible to export a 
document to HTML, see “Converting to HTML” on page 1268 in chap-
ter 31, Editing TTCN Documents (in Windows).

Print Preferences
It is also possible to set the default print options. For more information, 
see “Print Preferences” on page 255 in chapter 3, The Preference Man-
ager.
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Printing Documents – Some Examples
This section is a brief guide to how to print some types of documents. 
The remaining sections of this chapter contains more detailed reference 
information about the print function and the Print dialogs.

You can print documents either from the Organizer or from within an 
individual Telelogic Tau tool.

Printing from the Organizer
This is an example of how to print a table of contents, one or more SDL 
interaction diagrams and type views from the Organizer. It is assumed 
that you have SDL interaction diagrams included in the Organizer and 
that a Type Viewer is running. The example describes how to print spe-
cific diagrams, but what is explained here may of course apply to other 
types of diagrams.

To print from the Organizer:

The Print dialog will be issued, where you may change the print set-
tings. 

• Select Print | Print All from the File menu.

– Alternatively, click the quick-button for Print.
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You will start by changing the options in the Contents area:

1. Turn the Table of contents toggle button on.

2. Turn the SDL Interaction toggle button on.

The Print Setup dialog will be issued where you may specify other 
options:

Figure 73: The Organizer Print dialog

3. Click the setup button to the right of the SDL Interaction toggle but-
ton.
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– You select what to print by using the arrow buttons to move di-
agrams between the Print and Do not print lists. Multiple selec-
tion is possible.

– You may change the Scale of the printout.

– You may change the Orientation of the printout.

4. Click OK.

The dialog will be closed.

5. Turn the Type Diagram toggle button on, and click the setup button 
to the right of the toggle button.

The Print Setup dialog will be issued and you may set additional op-
tions.

– In the Print and Do not print lists, you may specify if any of the 
Type Viewer main window or Tree window (identified as Sub-
window in the list) is to be excluded.

Figure 74: The Print Setup dialog
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.

– You may also change the other settings in the dialog.

6. Click OK.

The Print Setup dialog will be closed.

You may also want to specify the options in the Document area and the 
Destination area of the Print dialog:

1. Select the Paper format that you want to use.

In the dialog, you may change the paper margins, and in addition 
you may define your own paper size.

3. You may also want to change other settings in the Document area.

4. Select the output format in the Format option menu. You may 
choose between:

2. Click the Margins button, to open the Paper Format Setup dialog.

Figure 75: Setting the margins
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– One PostScript File, suitable if you are going to print the docu-
ments on a PostScript printer.

– One EPS File (Encapsulated PostScript), suitable if you are go-
ing to include graphics in a document. Select One EPS File Per 
Page if multiple pages are to be printed.

– One FrameMaker MIF File, suitable if you want a file that can 
be imported into FrameMaker. Select One MIF File Per Page if 
multiple pages are to be printed.

– Import into FrameMaker (UNIX only), suitable if you want to 
import the file directly into a currently opened FrameMaker 
document.

– One Interleaf IAF File, suitable if you want a file that can be im-
ported into Interleaf. Select One Interleaf IAF File Per Page if 
multiple pages are to be printed.

– MSW Print (Windows only), which will make the print function 
use the printer you have set up with the Microsoft Windows 
Print Manager.

– One Word DOC File (Windows only), suitable if you want a file 
that can be used in Microsoft Word 97 or Word 2000.

– Word Files (DOC + EMF) (Windows only), suitable if you want 
to edit the document file in Microsoft Word and be able to re-
generate the pages.

– Web Files (HTML+PNG), suitable if you want to publish the 
document on the Web. HTML (text) and PNG (picture) files are 
produced that can be viewed in a web browser.

5. Select the destination of the printout – a file or a printer.

– If you want to save the printout on a file, you should make sure 
that the To file/Map file radio button is on. The button is labelled 
Map file if multiple pages are to be printed (when you have se-
lected a One file Per Page option in the format menu). The map 
file will contain a translation table that shows the correspon-
dence between the input diagrams and the generated files.
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– If you want to send the printout to a printer, you should ensure 
that the Execute radio button is on. You also have to type a print-
er command in the field, for example lpr. (It is possible to enter 
any post-processing command, such as a PostScript pre-viewer 
like ghostview.)

6. Click the Print button to generate the printout.

For more information on how to use advanced printing features, see 
“Advanced Print Facilities” on page 348.

Printing from the SDL Suite
In these examples you will learn how to print from the MSC Editor and 
the Type Viewer. As most settings in those print dialogs are similar to 
the ones in the Organizer dialog, described above, the explanations be-
low will be quite brief.

Printing from the MSC Editor

1. Open a diagram in the MSC Editor.

2. Select Print from the File menu.

The MSC Editor Print dialog will be issued.

3. Optionally, change the settings in the dialog.

4. Click the Setup button.

The Print Setup dialog will be issued, where you may specify some 
additional options:

Figure 76: The MSC Editor Print Setup dialog
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5. Turn the Print only selected symbols toggle button on, if you have 
selected parts of the MSC diagram that you want to print. Deselect-
ed symbols will not be printed.

6. Turn the Include Instance Ruler toggle button on, if you want to add 
an instance ruler into each printed page of an MSC. This means that 
the instance heads will be visible on each page – useful if you have 
a vertically extended MSC diagram that will cover more than one 
page.

7. Click the OK button in the Print Setup dialog.

8. Click the Print button in the Print dialog.

The printout will be generated.

Printing from the Type Viewer

1. Make sure the Type Viewer is running.

2. Locate either the main window (the window labelled Type Viewer) 
or the Tree window.

3. You may also want to change the contents of the window by using 
commands in the View menu.

4. Select Print from the File menu in either the main window or the 
Tree window of the Type Viewer.

If you select Print in the main window, the printout will be a type 
list. If you select Print in the Tree window, the printout will be an 
inheritance tree.

The Print dialog will be issued.

5. Adjust, if required, the options in the Print dialog and the Print Set-
up dialog.

6. Click the Print button.

The printout will be generated, based on the contents of the window 
that the Print command was selected in.
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Default Scope of Print
In this section you will find information on what will be printed by de-
fault if you do not change any settings. It may also be possible to select 
what documents – of parts of documents – to print. See “Print Setup Di-
alogs” on page 328 for more information on how to include more in the 
printout or how to restrict it.

Printing from the Organizer
The default printout in the Organizer depends on selections and which 
tools are running:

SDL, OM, SC, MSC and HMSC Diagrams; Text Documents; 
Cross Reference Files

If choosing Print | Print All or Print | Print Selected and no item is se-
lected in the Organizer, all documents that are managed by the Orga-
nizer (i.e. are visible in the Organizer view) will by default be included 
in the printout. If choosing Print | Print Selected and an item is selected 
in the Organizer, only the document(s) included in that item, and their 
sub-structure (if any), will by default be included in the printout.

Coverage Files

Coverage files cannot be included in the structure that is managed by 
the Organizer. The graphical presentation of a coverage file is computed 
as you request it by running the Coverage Viewer. 

Therefore, the graphical presentation of coverage information will be 
included in the printout if the Coverage Viewer is running. The result-
ing printout will reflect the current contents of the windows, that is, the 
Main Window and the Coverage Details Window of the Coverage 
Viewer.

SDL Types and Type Instances

These entities cannot be included in the structure that is managed by the 
Organizer. Furthermore, this information is computed automatically by 
the Type Viewer. Therefore, the Type Viewer must be running in order 

Note:

Link endpoints are never shown in a printed document.
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to include the information in the resulting printout. The contents of the 
Main Window and Tree Window of the Type Viewer may be included.

TTCN Documents

If a TTCN document is selected in the Organizer, it is possible to print 
it, and the default scope of print is the selected document. A TTCN doc-
ument cannot be included in a global printout, i.e. from the main Print 
dialog in the Organizer.

Printing from the SDL Suite
When you are going to print from an SDL suite tool, the printout will be 
the information that is currently visible in the active tool window.

The Setup button issues the Print Setup dialog which is used for speci-
fying the scope of print. For example, if you print from the SDL Editor, 
the default scope of print is the active SDL Editor window, i.e. the SDL 
page currently being edited. In the Print Setup dialog, the scope of print 
may include any of the pages contained in the SDL diagram, or be re-
stricted to the SDL symbols currently selected in the active window.

OM, SC, HMSC, SDL, MSC and Text Editor

The default scope of print is the active Editor window, i.e. the diagram 
page or the MSC currently being edited.

SDL Overview Viewer

The default scope of print is the active SDL Editor window, i.e. the SDL 
Overview diagram currently being viewed.

Type Viewer, Index Viewer and Coverage Viewer

In a Viewer, the scope of print is the contents of the window from where 
you invoked print.

Preference Manager and Link Manager

The scope of print is the current contents of the window.
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Printing from the TTCN Suite
The default scope of print is the entire, currently active, TTCN docu-
ment. The printout will contain one table per page.

The Print Dialogs in the SDL Suite and in 
the Organizer

To print, you select any of the submenus in the Print menu from the File 
menu. This will open a Print dialog. Since the print functions in the 
tools are not identical, the print dialogs look somewhat different de-
pending on where they are invoked from. As you can see in Figure 77 
and Figure 78, the differences are that the Organizer print dialog in-
cludes the Contents area, whereas the SDL suite tool print dialogs in-
clude a Setup button. 

The main differences between printing from the Organizer and an SDL 
suite tool are:

• In an SDL suite tool, it is only possible to print the information or 
document that is opened in the tool. In the Organizer, you can select 
to print all or any of the documents that are managed by the Orga-
nizer.

• It is possible to print only selected symbols (when applicable) from 
an SDL Suite Editor, which is not possible from the Organizer. 

• When you print from a viewer, the printout will be the contents of 
the active window. If you print from the Organizer, it is possible to 
include or exclude a window from the printout, independently of 
which window is currently active. 

• In the Organizer it is also possible to print a table of contents and the 
contents of the Organizer window.

Note:
Endpoints are not displayed in printed documents/diagrams, regard-
less of the value of the Show Link Endpoints option.
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Both dialogs contain the following areas and buttons:

Figure 77: The Organizer Print dialog

Figure 78: An SDL Suite tool print dialog
July 2003 Telelogic Tau 4.5 User’s Manual ,um-st1 309



Chapter 5 Printing Documents and Diagrams 
• Document Area
• Destination Area
• Print button
• Default button
• Cancel button

The Organizer print dialog also contains the Contents area with setup 
buttons, and a Save button. A Setup button is also included in each the 
SDL suite tool print dialog. The setup buttons in the Contents area of 
the Organizer print dialog are equivalent to the Setup button in an SDL 
suite tool print dialog. The Save button is used to save print dialog set-
tings in print selection files, for later use in the print dialog.

All dialog areas and buttons will be described in this chapter.

Contents Area in the Organizer Dialog
The Contents area is only available in the Organizer Print dialog. In the 
area, it is possible to control what information to print, through a num-
ber of toggle buttons and Setup buttons. Each of the toggles identify a 
group of documents that may be printed:

• Table of contents
• Organizer view
• Link Manager view
• OM diagram
• HMSC diagram
• SC diagram
• SDL interaction
• SDL flowchart
• SDL overview
• MSC diagram
• Text document
• Coverage diagram
• Cross reference diagram
• Type diagram

Note:

It is not possible to include TTCN documents in a global printout 
from the Organizer. See “The Print TTCN Dialog in the Organizer” 
on page 322 for information on how to print TTCN documents from 
the Organizer.
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Some toggle buttons may be turned on by default. This is determined by 
which document types that are present in the default scope of print.

Table of Contents

This option determines whether a table of contents should be generated 
or not. The table of contents consists of a textual list with information 
about what source diagrams and generated diagrams that are included 
in the printout, with references to physical page numbers. There is also 
a possibility to only include Organizer chapters in the table of contents, 
i.e. all other printed entities are suppressed in the table of contents.

The table of contents is either printed on the first pages that constitute 
the resulting printout, or after an initial text document acting as a title 
page.

Organizer View

This option determines whether a printout of the Organizer main win-
dow should be included or not in the generated output. Only the visible 
parts (i.e. expanded nodes) are included. 

The resulting printout will match the Organizer’s View Options, i.e. file 
names, directories, etc. will be shown if they are in the Organizer Main 
window. 

Link Manager View

This option determines whether a printout of the Link Manager Window 
should be included or not in the generated output. Only the visible parts 
(i.e. expanded nodes) are included. 

OM/HMSC/SC/MSC/Text Diagram, 
SDL Interaction, 
SDL Flowchart, 
SDL Overview

These options determines whether the documents and diagrams that are 
visible in the Organizer should be included or not in the printout. The 
SDL Interaction diagrams are: system, system type, block, block type, 
substructure, package diagrams. The SDL Flow diagrams are: process, 
process type, service, service type, procedure, operator, macro dia-
grams.
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Coverage Diagram

This option determines whether Transition Coverage and Symbol Cov-
erage trees should be included or not in the generated output. 

Cross Ref Diagram

This option determines whether Definitions and Uses should be includ-
ed or not in the generated output. 

The resulting output will show the graphical appearance as when dis-
played in the Index Viewer, with the exception that only SDL entities 
defined or used in SDL diagrams printed together with the index will be 
visible in the index.

Type Diagram

This option determines whether an SDL-92 Type list and SDL Type In-
heritance and Redefinition list should be included in the generated out-
put or not.

The resulting output will show the SDL-92 type lists for the SDL system 
currently in view in the Organizer. The lists will be produced by using 
the options defined in the List Options, Tree Options and Symbol Op-
tions of the Type Viewer. 

Setup Buttons in the Contents Area

Furthermore, each group of documents that may be printed is supplied 
with setup buttons. When you click a setup button, a Print Setup dialog 
will be issued, see “Print Setup Dialogs” on page 328. In the dialog, it 
is possible to set additional options that affect the printout of the current 
group of documents.

Document Area
The Document area contains a number of settings that make it possible 
to specify the size of the paper to use, the print range and additional in-
formation to be printed on each individual page. 

The Document options are:

Note:

Endpoint markers will not be included in printed diagrams.
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• Paper format
• Margins
• Header file
• Footer file
• Page markers
• First page no
• Print from/to
• Black & white
• Print collapsed texts
• Print chapter pages
• Forward references
• Backward references

Paper format

The Paper format option menu specifies what paper format the print 
function will use. The paper formats are:

• A4, the European standard size(210 * 297 mm)
• A3, the European standard double size (297 * 420 mm)
• US Letter, the American standard (8.5” * 11”)
• US Legal (8.5” * 14”)
• User Defined, which makes it possible to customize a size with the 

Margins button. The size may also have been set in the Preferences 
Manager.

Margins

The Margins button provides access to the Paper Format Setup dialog 
where the print margins may be specified.

Note:

When using a printing format other than One Postscript File or 
MSWPrint the only enabled options in the Document area are Black 
& white (not for Frame or Interleaf printing) and Print collapsed 
texts. For these formats the paper layout is determined by the special 
Print preferences starting with  Frame*PaperFormat. However 
when using Word format the margins and layout are determined by 
the defaults given by the created Word document.
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The print margins govern how much space is reserved around the area 
used when printing. Values are expressed in millimeters.

• There are four slide bars for the adjustment of the margins:

– Upper margin
– Lower margin
– Left margin
– Right margin

Margins are calculated with respect to the closest border and remain 
unaffected when rescaling, changing the paper size or the orienta-
tion of the printout.

• The dialog also contains two slide bars used for controlling what pa-
per format to use when the Paper format option User Defined is set:

– User paper width
– User paper height

• The OK button applies the values as currently defined and closes the 
dialog.

• The Cancel button closes the dialog without changing any values.

Header file
Footer file

This feature controls whether or not a header/footer should be printed 
on each page. The page header/footer is defined in a text file of its own, 
which you need to supply. For information about the contents and syn-
tax of this file, see “Footer and Header Files” on page 335.

• The header/footer file options are turned on/off with toggle buttons.

Figure 79: The Paper Format Setup dialog
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• When you click the folder button, a Select File dialog will be issued. 
In this dialog you may select the header/footer file.

• It is also possible to type the name and directory of the file directly 
into the text field.

Page markers

An SDL/OM page or an MSC diagram may require multiple physical 
pages when printed. If you want to print an SDL/MSC/OM document 
and the document is physically spread over more than one physical 
page, the Page markers toggle button facilitates the reassembling of the 
paper sheets into the original page. 

• If the toggle button is on, adjacent page markers will be inserted on 
the edge of each physical page. An adjacent page marker looks like 
a small arrowhead which refers to the adjacent page. If there are 
lines crossing a physical page border, line identifiers (like X1, X2... 
or Y1, Y2...) will be attached to the line, making it easy to find the 
continuation of the line on the other page.

Note:

Header or footer files are only supported in PostScript Output (not 
EPS) or MSWPrint Output (Windows only).

Figure 80: The page numbering

Physical page numbering follows a “first right, then down” fashion.

1

76 8

432

5
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First page no

When you order multiple print jobs, you may want to restart the page 
numbering on each printout with a number different from 1, which is the 
default value.

If you want to change the number of the first page, you should type the 
number in the First page no: field.

Print from/to

It is possible to exclude a number of pages form a printout. To specify 
the print range, you type the page numbers in the Print from and Print 
to fields. Make sure that the toggle button is on, your settings will have 
no effect otherwise. 

When the toggle button is off, all physical pages that constitute the 
printout will be generated.

Black & white

If this option is selected, all symbols and lines will be printed with a 
black border on a white background. If this option is not selected, sym-

Note:

The physical page breaks are indicated with dashed lines in the dia-
gram editors. A page number is inserted at the lower right corner of 
each page in the editor.

Page markers and all other options where page numbers are used are 
only supported in PostScript Output (not EPS) or MSWPrint Output 
(Windows only).

It is possible to print an individual page number on each printed 
page. This is done by using a header file. Read more about header 
files in “Footer and Header Files” on page 335.

Note:

The print range must be in accordance with the page numbering; i.e. 
the offset specified in the First page no should be added.

The physical page breaks are indicated with dashed lines in the dia-
gram editors. These page breaks are valid only if the printing scale 
is not changed.
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bols and lines will be printed with the color they have on screen. As de-
fault, this option is off.

For FrameMaker or Interleaf printing this option is always on and dis-
abled as the printing will always be in black and white.

Print collapsed texts

Text symbols, comment symbols and text extension symbols can be col-
lapsed. When they are collapsed, it is not possible to see the complete 
text these symbols contain in the diagram. Instead, it is possible to print 
the complete text as a separate text page after the diagram. This option 
decides if such a text page should be printed or not. As default, this op-
tion is on.

Print chapter pages

(Organizer only.) Decides if text connected to chapter symbols in the 
Organizer should be printed or not. As default, this option is on.

Forward references

(Organizer only.) Decides if forward paper page references should be 
printed or not. Paper page references makes the printout easier to read. 
You can get paper page references for the following relations:

• SDL reference symbol -> SDL diagram
• (H)MSC reference symbol -> (H)MSC diagram
• SDL join/out-connector -> SDL label/in-connector
• SDL procedure call -> SDL procedure diagram
• SDL nextstate symbol -> SDL state symbol

As default, forward paper page references are printed.

There is a preference, Print*MaxPageReferences, that decides the max-
imum number of page references in one place. The default value is 20. 
A value of 0 is the same as “no limit”.

Note:

The three last relations will only be printed if there exists an in-
dex/cross reference file in the Organizer view with up-to-date infor-
mation about the SDL system. You can get an index for a correct 
SDL system by pressing the Generate Index Organizer quick button 
before bringing up the print dialog
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Backward references

Similar to forward references, but produces paper page references that 
allows the reader of the printout to follow the flow backwards instead.

Destination Area
The Destination area contains print options that affect the output format 
and the destination of the resulting output. It is for example possible to 
send a printout to a printer or to look at the results in a pre-viewer.

The options are:

• Format
• To file / Map file
• Execute

Format

This feature controls what output format will be generated when print-
ing. You select the output format in an option menu. The output formats 
supported are:

• One PostScript File 

This option produces one self contained PostScript document.

• One EPS File1

If only one page is to be printed, this option is valid and will result 
in an EPS File containing one physical page. If the Print setup 
caused more than one physical page to be printed, only the first page 
will be printed. The layout of the page for EPS printing is deter-
mined by the preferences in Frame*PaperFormat.

• One EPS File Per Page

This format implies that the output will be in the form of multiple 
EPS files, placed in a specified directory. Along with the EPS files, 
a map file containing the translation scheme is produced. See “To 
file / Map file” on page 320.

• One FrameMaker MIF File2

1. EPS stands for Encapsulated PostScript
2. MIF stands for Maker Interchange Format.
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This format signifies the generation of one FrameMaker MIF file. 
The file will contain a number of contiguous, cropped anchored 
frames. The layout of the page for MIF printing is determined by the 
preferences in Frame*PaperFormat.

• One FrameMaker MIF File Per Page

This option produces one FrameMaker MIF file per page. A map 
file is also produced, showing the translation table. See “To file / 
Map file” on page 320, below.

• Import into FrameMaker (UNIX only)

If an instance of FrameMaker is found up and running, this option 
generates a FrameMaker MIF temporary file that will be imported 
into an anchored frame, placed below the current insertion point in 
the active FrameMaker document. If no instance of FrameMaker is 
found, then an attempt is made to start one with the command maker 
and create a new FrameMaker document, showing the contents of 
the file.

See also “Importing into FrameMaker (UNIX only)” on page 344 
for how this option functions when multiple instances of 
FrameMaker are running on your computer.

• One Interleaf IAF File1

This format produces one Interleaf ASCII Format file. The layout of 
the page for IAF printing is determined by the preferences in 
Frame*PaperFormat.

• One Interleaf IAF File Per Page

Note:

To have this print option function properly, the SDL suite and 
FrameMaker must run on the same computer.

Temporary files are stored on the directory designated by the envi-
ronment variable TMPDIR. You have to set up the variable as a com-
plete path specification such as setenv TMPDIR /tmp
To specify TMPDIR such as setenv TMPDIR . is not sufficient.

1. IAF stands for Interleaf ASCII Format.
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This option produces one Interleaf ASCII Format file per page. A 
map file is also produced, showing the translation table. See “To file 
/ Map file” on page 320.

• MSW Print 
(Windows only)

The Print function uses the printer that has been set up with the Mi-
crosoft Windows Print Manager. If a printer that does not support 
PostScript is used, this option makes sure the printer driver avail-
able in Microsoft Windows is used.

• One Word DOC File
(Windows only)

This option produces one Word Document format file for use with 
Microsoft Word 97 or Word 2000. The layout of the page for Word 
printing is determined by the margins and paper format as defined 
when a new document in Word is created.

• Word Files (DOC + EMF)
(Windows only)

This option produces one Word Document format file that is a hub 
for a set of Enhanced Metafiles. When you select this option you 
also have to specify the main Word Document file in the To file text 
field. The produced Enhanced Metafiles are auto-named and placed 
in the same directory as the main Word Document file.

• Web Files (HTML+PNG)

This option produces HTML (text) and PNG (picture) files that can 
be viewed in a web browser. The PNG file format is similar to the 
GIF file format and is supported by Netscape Navigator 4.0 and Mi-
crosoft Internet Explorer 4.0 or later. When you select this option, 
you also have to specify the main HTML file in the To file text field. 
All other produced files are auto-named and placed in the same di-
rectory as the main HTML file.

To file / Map file

If this radio button is turned on, the output will be a file. The name of 
this radio button depends on the format specified in the Format option 
menu. If the format selected will generate one output file – i.e. the for-
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mat name ends with Per Page – the name will be Map file. Otherwise it 
will be To file.

A map file contains a translation scheme of all files generated (contain-
ing information about SDL diagram / page and the corresponding print-
out file). The naming algorithm of the generated files will ensure a fixed 
mapping between a diagram and the generated files between two subse-
quent Print jobs. However, if the input to the Print function is changed 
(its size!), this is not necessarily true.

See “Map File” on page 341 if you want detailed information on the 
syntax of a map file.

• When you click the folder button, a Select File dialog will be issued. 
In this dialog you may select the name of the file and where it is to 
be saved.

• It is also possible to type the name of the file directly into the text 
field. The directory where the file will be saved is the most currently 
selected.

Execute

If this radio button is on, the output file will be used as input to an OS 
command. An example of this is to load a printer with a PostScript file. 
It may also be used to send the resulting PostScript code to a PostScript 
previewer. For instance, if type a previewer command in the field – 
ghostview for example – you may preview the PostScript file.

The command lpr (or any other related) will send the printout to a 
printer.

The default command is specified in the Preference Manager. In the 
Windows version, the command lpr is available, which functions 
much like the corresponding UNIX print spool command.

Setup
When you click the Setup button (only available in an SDL suite tool 
Print dialog), a Print Setup dialog will be issued. In the dialog, it is pos-
sible to set additional options. The additional options differ between the 
the SDL suite tools. See “Print Setup Dialogs” on page 328 for more in-
formation.
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The Print TTCN Dialog in the Organizer
To print one or more TTCN documents from the Organizer, you select 
one of the TTCN document in the Organizer and then you select Print 
from the Organizer File menu. This will issue the Organizer Print 
TTCN dialog.

When you print a TTCN document, the main difference between print-
ing from the Organizer and printing from the TTCN suite is:

• If you have more than one TTCN document included in the Orga-
nizer, you may select which of the documents to print. In the TTCN 
suite, it is only possible to print a document that is displayed in the 
active Browser.

See also “The Print Dialogs in the TTCN Suite” on page 324.

The Organizer Print TTCN dialog contains options for the print range 
and first page number and whether the document is to be printed to a file 
or a printer. More options are available in the Print TTCN Setup dialog.

First page number
The number that you type in this field, will be the page number inserted 
on the first page.

Figure 81 The Organizer Print TTCN dialog
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Print from/to
It is possible to exclude a number of pages form a printout. To specify 
the print range, you type the page numbers in the Print from and Print 
to fields. Make sure that the toggle button is on, your settings will have 
no effect otherwise. 

When the toggle button is off, all physical pages that constitute the 
printout will be generated.

Destination Area
The options in the Destination area affects the destination of the print-
out.

To file

If this radio button is on, the printout will be a PostScript file. You also 
have to specify the name of the file and where it is to be saved.

• When you click the folder button, a Select File dialog will be issued. 
In this dialog you may select the name of the file and where it is to 
be saved.

• It is also possible to type the name of the file directly into the text 
field. The directory where the file will be saved is the most currently 
selected.

Execute

If this radio button is on, the output file will be used as input to an OS 
command. An example of this is to load a printer with a PostScript file. 
It may also be to send the resulting PostScript code to a PostScript pre-
viewer. For instance, if type a previewer command in the field – 
ghostview for example – you may preview the PostScript file.

The command lpr (or any other related) will send the printout to a 
printer.

Setup
When you click the Setup button, a Print Setup dialog will be issued. In 
the dialog, it is possible to set additional options, such as which of the 
existing TTCN documents to print. See “Print Setup Dialogs” on page 
328 for more information.
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The Print Dialogs in the TTCN Suite

When you print a TTCN document, the main difference between print-
ing from the Organizer and printing from the TTCN suite is:

• If you have more than one TTCN document included in the Orga-
nizer, you may select which of the documents to print. In the TTCN 
suite, it is only possible to print a document that is currently dis-
played in the active Browser.

See also “The Print TTCN Dialog in the Organizer” on page 322.

Printing in the TTCN Suite in Windows
In Windows, the print dialogs are Windows standard. Besides the actual 
Print dialog there are also Print Setup and Print Preview dialogs.

To open a Print Setup dialog:

• Select Print Setup from the File menu.

In the dialog, it is possible to specify what printer, paper size and pa-
per orientation to use.

To open a print preview dialog:

• Select Print Preview from the File menu.

In the dialog, the TTCN document is displayed as it will be printed 
and it is possible to zoom and browse the document.

To print from the TTCN suite:

• Select Print from the File menu. (On UNIX, this menu choice is in-
cluded in the Browser.)

– In Windows, if the test suite overview has not been generated 
previously, you will have to confirm the generation before the 
test suite can be printed.

In the Print dialog that will be opened, you may specify the page 
range and if the file is to be printed to a file or a printer. The output 
will be in TTCN-GR format – the graphical format of TTCN – ac-
cording to ISO/IEC 9646-3, and it will include document indices 
and automatic page numbers. 
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Printing in the TTCN Suite on UNIX
On UNIX, you can select which Browser parts and items, for example a 
single table or sets of tables, to include in the printout. The selections 
may be arbitrary – they will be printed as a coherent document anyway. 
It is also possible to change the page numbering of the printout.

The settings in the print dialog will be described below:

• Log device

Controls the log device for the print function. The default value is 
Screen, but the log can be directed to a named file (File) or turned 
off altogether (None).

For more information, see “The TTCN Suite Logs” on page 6 in 
chapter 1, User Interface and Basic Operations.

• Output device

If you specify the output device to be a printer, you also have to fill 
in a print command. If you want to print to a file, you will have to 
specify the destination. See also “Printing PostScript Files” on page 
326.

Figure 82: The TTCN suite Print dialog on UNIX
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• Burst page off

If this option is set, the burst page will not be printed. The burst page 
is a generated, unnumbered cover page for the TTCN document, 
containing the print date and time.

• Double sided

If this option is set, the TTCN document will be printed in a page 
format suitable for a double-sided copying, otherwise it will be 
printed in a single-sided format. The appearance of both formats is 
controlled by resources and can therefore be changed (see the file 
<Itex.sample> in the TTCN suite directory).

• First page number

You may change the page number of the first page. However, to en-
sure consistency between the page numbering of the printed TTCN 
document and the page numbers that appear in the TTCN document 
overview, make sure that:

– The Overview Part is generated before you print.

– The same first page number is used both in the document over-
view and the printout.

• Printing page ranges

– All causes all pages of the document to be printed. 

– Start page and End page restricts the printout.

Example 13 ––––––––––––––––––––––––––––––––––––––––––––––––

If a TTCN document contains ten pages numbered 1 to 10, then Start 
page = 3 and End page = 3 will cause only page 3 to be printed.

––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

Printing PostScript Files

The editable field of the Print dialog not only allows to change the name 
of the printer or to apply flags to the print command. It is also possible 
to insert the name of a filter for the produced PostScript code. In the 
public domain there exist a package of programs called pstools that 
make various magic operations with a PostScript file. The following ex-
ample will print four TTCN suite pages on each A4 page (the syntax of 
pstops is somewhat hard to read though):
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Example 14 ––––––––––––––––––––––––––––––––––––––––––––––––

pstops ‘4:0@0.5(0.8cm,14cm)+1@0.5(10.5cm,14cm)\
+2@0.5(0.8cm,0cm)+3@0.5(10.5cm,0cm)’ | lpr

––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

Other filters are able to print double sided intended to bind into a book, 
print odd pages first etc.

By using a PostScript viewer as Ghostview instead of the normal print 
command, the printout of the TTCN document can be viewed on screen 
rather than being printed:

Example 15 ––––––––––––––––––––––––––––––––––––––––––––––––

ghostview -

––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

The text in this field is controlled by the resource Itex.print.com-
mandPrefix. This is by default lpr -P or lp -s depending on plat-
form but can be altered (note that the content of the environment vari-
able PRINTER/LPDEST is concatenated to this string). See chapter 30, 
Customizing the TTCN Suite (on UNIX) which contains a description on 
how to modify resources in the TTCN suite.
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Print Setup Dialogs
A Print Setup dialog will be issued when you click the Setup button in 
an SDL suite tool Print dialog, or when you click any of the setup but-
tons in the Contents area of the Organizer Print dialog. When you click 
the Setup button in the Organizer Print TTCN dialog, the Print TTCN 
Setup dialog will be issued. The settings in a setup dialog will affect the 
current group of documents.

The setup dialogs look somewhat different depending on the tool they 
are invoked from. There are four types of print setup dialogs:

• Print Setup dialog for Table of contents in the Organizer, see 
Figure 83.

• Print Setup dialog in the SDL, OM, SC and HMSC Editors and, 
when applicable, in the Organizer, see Figure 84.

• Print Setup dialog in the MSC Editor, see Figure 85.

• Print Setup dialog in tools not mentioned above and, when applica-
ble, in the Organizer, see Figure 86.

• Print TTCN Setup dialog in the Organizer, see Figure 87.

Figure 83: The Table of contents Print Setup dialog
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Figure 84: The Organizer Print Setup dialog

The Print Setup dialog looks the same in the Organizer and the SDL, OM, SC and 
HMSC Editors.

Figure 85: The MSC Editor Print Setup dialog

Print list Do Not Print list

Scale options Additional options Orientation options
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Figure 86: A viewer Print Setup dialog

The Print Setup dialog looks the same in the Link Manager, Type Viewer, the Index 
Viewer, the Coverage Viewer and the Text Editor.

Figure 87 The Organizer Print TTCN Setup dialog
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The setup dialogs contain the following:

• All dialogs contain the Scale area, the Orientation option menu, and 
the OK, Cancel and Help buttons.

• When applicable, the SDL, HMSC, OM and SC Editor and the Or-
ganizer Print Setup dialogs, as well as the Organizer Print TTCN 
Setup dialog, also contain the Print / Do not print lists. 

The lists are only included in the Print Setup dialog of an editor if 
the diagram that is to be printed consists of more than one page.

In the Organizer, the Print Setup dialog will not contain the lists if 
you clicked the Link Manager View setup button.

• The Print only selected symbols toggle button is included in the 
SDL, HMSC, OM and SC Editor Print Setup dialogs.

• The MSC Print Setup dialog contains the Include Instance Ruler 
toggle button. This button is also included when MSC setup is in-
voked from the Organizer Print dialog.

• The Organizer View Print Setup dialog contains the Paper page ref-
erences toggle button. 

• The Table of contents Print Setup dialog contains the toggle buttons 
After initial text document and Only chapters in TOC.

• The Print TTCN Setup dialog contains the toggle buttons Document 
burst page, Part burst page and Double sided.

All areas and options mentioned will be explained below.

Print / Do not print
• The Print list shows the documents/pages that will be printed. 

If the Print Setup dialog is invoked from the Organizer, the list con-
tains the documents included in the Organizer scope of print. When 
the dialog is invoked from the SDL, OM, SC or HMSC Editor, the 
list contains the current page.

In the Print TTCN Setup dialog, this list shows the TTCN document 
that was selected in the Organizer (or all TTCN documents within a 
TTCN Module). Any other TTCN documents are listed in the Do 
Not Print list.
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• The Do not print list shows the documents/pages that will not be 
printed. 

When invoked from the SDL, OM, SC or HMSC Editor, the list 
contains the pages that are included in a diagram, except the current 
page.

To specify what is to be printed and not:

Scale
It is possible to set the scale in almost all Print Setup dialogs. You can 
select Percent, Scale to fit page or Scale to fit width.

Percent

With the Percent radio button on, the printout of the current document 
category will be scaled according to the value defined in the Percent 
text field. The default value is 100% but you may of course change this.

Scale to fit page

With the Scale to fit page radio button on, the printout will be rescaled 
– if needed – to fit the physical paper size.

1. Select one or several items in one of the lists, if you want to move 
them to the other. Multiple selection is possible.

2. Use the arrow buttons to move selected items from one list to the 
other.

Note: 

On UNIX, you may transfer all diagrams/pages between the two lists 
by pressing <Shift> while clicking an arrow button.

Note:

It is not possible to set the scale in the Text Editor Print Setup dialog 
or in the Organizer Print TTCN Setup dialog.
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Scale to fit width

With the Scale to fit width button on, the documents will be rescaled in 
order to fit the physical paper width. The result becomes a column of 
pages constituting each document.

Orientation
In the Orientation options menu you may choose between the following 
orientations of the printout:

• Portrait
• Landscape 

By changing the options, you can rotate the printout in order to optimize 
paper use.

Additional Options
Below the Orientation option, there are a number of additional options, 
depending on which Print Setup dialog you have opened.

Print only selected symbols

If this toggle button is on, only objects that are selected in a window will 
be printed. This option is not available when you print from the Orga-
nizer. In an SDL suite tool, it is disabled if no object is selected or if 
more than one window contain a selection. 

Include Instance Ruler

This toggle button is only available in the MSC Print Setup dialog. It 
specifies whether an instance ruler (see “Instance Ruler” on page 1680 
in chapter 40, Using Diagram Editors) should appear on each printed 
page or not. The instance ruler is, when printed, given an appearance 
similar to the one shown in the MSC Editor window.

Note:

The Orientation option is only enabled for the output formats One 
PostScript File or MSWPrint. Other formats use the portrait orienta-
tion but the layout can be adjusted by the preferences 
Print*Frame*XXX.
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Paper page references

This toggle button is only available in the Organizer View Print Setup 
dialog. It specifies whether paper page references to all printed dia-
grams and documents should be included in the Organizer view listing.

After initial text document

This toggle button is only available in the table of contents Print Setup 
dialog. It specifies whether the table of contents should be printed after 
a plain text document placed first among the diagrams and documents 
that are to be printed. The initial text document then acts as a title page 
before the table of contents.

Only chapters in TOC

This toggle button is only available in the table of contents Print Setup 
dialog. It specifies whether only the chapters in the Organizer view 
should be included in the table of contents, or if all diagrams and docu-
ments also should be included.

Document burst page

This toggle button is only available in the Organizer Print TTCN Setup 
dialog. If the toggle is on, a document burst page will be printed. The 
burst page is an unnumbered cover page for the TTCN document, where 
the name of the test suite and the print date are printed.

Part burst page

This toggle button is only available in the Organizer Print TTCN Setup 
dialog. If the toggle is on, part burst pages will be printed. The part burst 
pages are unnumbered cover pages, that separate the different parts of a 
TTCN document. The name of the part, the test suite and the print date, 
are printed on each part burst page.

Double sided

This toggle button is only available in the Organizer Print TTCN Setup 
dialog. If the toggle is on, the TTCN document will be printed with a 
page format suitable for a double-sided copying. The appearance is con-
trolled by resources and can therefore be changed (see the file 
Itex.sample in the TTCN suite directory of the Telelogic Tau instal-
lation).
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Footer and Header Files
You may specify if a header and/or footer is to be inserted on each print-
ed page. The first thing you have to do is to define the header and footer 
in separate text files. The format is ASCII based and line oriented. A 
number of variables are available, providing additional information of 
the kind of diagram printed. 

Text is written on a white background, which becomes visible if the text 
appears on top of any graphical object.

Printing Order
The priority order for writing headers and footers is as the inverse order 
in which the items appear in the file. That is any text, variable or graph-
ical symbol, overwrites an already written item. (The last row in the file 
has the highest priority).

Syntax
The syntax used in the header and footer files is given below in a BNF 
notation:

File ::= ( <LINE> | <EXTENSION-LINES> | 
<EPSF> ) *
<LINE> ::= <X> <Y> ( <TEXT> | <VARIABLE> ) 
+ \n
<X> ::= integer, x - position in 
millimeter
<Y> ::= integer, y - position in 
millimeter
<TEXT> ::= any ASCII text - no newlines 
allowed
<VARIABLE> ::= any variable as described  in 
“Variables” on page 336, 
<EXTENSION-LINES> ::= any of the extensions as 
defined in “Extensions” on page 338.
<EPSF> ::= EPSF <X> <Y> <FILE>
<FILE> ::= user provided filename 
containing EPS code

Note:

The positions are relative the upper left corner of the physical pa-
per in the header and the lower left corner in the footer.
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Variables
The following variables are supported in header and footer files:

Variable Explanation

<date> As set by the Print preference date.

<diagramname> The name of the diagram. Ignored if the printed 
diagram was not one of: 
• SDL diagram
• SDL Overview diagram
• MSC.

<diagramtype> The type of the diagram. Ignored if the printed 
diagram was not one of: 
• SDL diagram
• SDL Overview diagram
• MSC.

<pagename> The logical name of current page. Ignored if 
the printed diagram was not one of: 
• SDL diagram
• SDL Overview diagram.

<file> The current file being printed. Ignored if no 
corresponding file exists. It could be a New 
(unsaved) file being printed or it could be a 
Type View which has no corresponding file.

<page> The current page number.

<directory> The directory where the current file is located. 
Ignored if no corresponding file exists. It could 
be a New (unsaved) file being printed or it 
could be a Type View which has no correspond-
ing file.

<chaptername> The current chapter name, defined by a chapter 
symbol in the Organizer View.

<chapternumber> The current chapter number, defined by a chap-
ter symbol in the Organizer View.

<totalpages> The total number of printed pages, excluding 
the title page and the table of contents.
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Obsolete Variables

(i.e. variables used in SDT 2.3)

Example 16 ––––––––––––––––––––––––––––––––––––––––––––––––

For example, you may have a process called Myproc that you are going 
to print out. First you write a footer file with the following contents:

10 20 Telelogic AB
10 15 <date>
150 15 <diagramtype> <diagramname> <pagename>
180 20 Page <page>

If the date is March 1, 1999, the 15th printed page would look some-
thing like this:

––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

Variable Explanation

<area> Prints Work Area or Original Area in plain text 
depending on if the diagram was found in the 
source directory or not. 
The variable is available for backwards compati-
bility only.

Figure 88: The resulting footer

Telelogic AB                                               Page 15
1999_03_01                               Process Myproc 1            

20 mm
15 mm

10 mm                                   150 mm     180 mm
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Extensions
Below are listed the extensions that enhance the appearance of the head-
er and footer.

Frames

The keyword FRAME makes a frame appear at any position on the paper. 
The function is intended for framing the header and/or footer. 

Format

The exact format is:

FRAME x1 y1 x2 y2 [type]

where the start and stop positions are given in millimeters. The optional 
type argument may be either 3D or plain (default).

Separators

A separator is a horizontal line which is intended to separate the header 
and/or footer from the data area of a printed page. 

Figure 89: 3D frame and plain frame

‘3D’ Frame

‘plain’ Frame

(x1, y1)

(x2, y2)

(x1, y1)

(x2, y2)
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Format

The SEPARATOR statement has the general format:
SEPARATOR x1 y1 length [type]

where the start position and length of the separator are given in millime-
ters. The optional type argument may be either: 

• Filled
• Double
• Single (default)

Boxes

Use the BOX keyword to make a filled rectangle appear anywhere on 
the paper. It can be used for highlighting sections of the header and/or 
footer. 

Format

The format is:
BOX x1 y1 x2 y2 [grayscale]

where the start and stop positions are given in millimeters. The optional 
grayscale argument is a number in the range 0 to 100 (default is 50).

Figure 90: Filled, double and single separators

Figure 91: Boxes

 Grayscale=0 = white, grayscale=50 = medium gray and grayscale=100 = black.

(x1, y1)

(x1, y1)

(x1, y1)

length

‘filled’

‘double’

‘single’

0 50 100
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Defining Multiple Footers and Headers
It is possible to have a separate footer or header for the first printed 
page. There are three keywords that can be typed on a separate line in a 
footer or header definition file to achieve this:

• IFFIRST

Definitions after this keyword will only be used for the first printed 
page.

• IFNOTFIRST

Definitions after this keyword will be used for all pages after the first 
page, but not for the first page.

• ENDIF

Definitions after this keyword will be used for all pages.
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Map File
When multiple output files are generated for one input diagram, a map 
file is also generated. It shows the translation table between input dia-
grams and resulting files. The name of this file should be specified in 
the Map file field.

Syntax
The map file is an ASCII text file containing lines of the format:

<filename> “[<diagram type>]” “[<diagram name>]” 
“[<page name>]”

where <filename> is an absolute path to a generated file. The file name 
is composed of:

• the first four letters of the diagram name (fewer if the diagram name 
is shorter than four letters) 

• the first two letters of the page name 
• an extension. 

If this naming scheme generates two files with the same name, a number 
(1-99) is added to the second file name, preceding the extension.

Example 17: Contents of a UNIX Map File –––––––––––––––––––––––

...
/usr/ope/doc/ContDe.eps “Block” “Controller” 
“Declarations”
...
/usr/ope/doc/ContDe1.eps “Block” “Container” 
“Declarations”
...

Example 18: Contents of a Windows Map File––––––––––––––––––––

...
C:\tau\doc\ContDe.EPS “Block” “Controller” 
“Declarations”
...
C:\tau\doc\ContDe1.EPS “Block” “Container” 
“Declarations”
...

––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

Should either of the descriptive <diagram type>, <diagram name> or 
<page name> fields be inapplicable to an item, the corresponding field 
in the map file will be empty (i.e. ““).
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More Information on Output Formats

PostScript Output
PostScript output may be generated as one standard PostScript file or 
one or more Encapsulated PostScript (EPS) files. When multiple EPS 
files are generated, a translation table will also be produced in a Map 
File, linking the name of a generated file to the contents.

Standard PostScript

A normal print operation generate one PostScript document. All data is 
represented uniformly, using the same paper format, header, footer etc. 
Only the scale and orientation might vary between pages. 

Encapsulated PostScript (EPS)

The EPS output makes use of the scale and orientation settings for each 
document category. Since EPS files are not clipped, the internal scale 
has little importance when the file is imported into an external docu-
mentation or desktop publishing system.

Header, footer and adjacent page markers are not included in the output. 
Paper layout are determined from the Print preferences Frame*Paper-
Format.

Scaling in EPS Files

The scaling options are handled as follows:

• Scale to fit page

Each logical page is output as one EPS file with an internal scale ad-
justed to fit the entire logical page into the bounding box given by 
the current paper format and margins. When the EPS files are scaled 
into external documentation software, this will correspond to the 
“Fit Into Page” option for PostScript files.

• Percent

As Scale to fit page, but with a user defined internal scale.

• Scale to fit width
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As Scale to fit page, but with the internal scale adjusted to fit the 
width of the logical page into the space given by the paper width and 
the left and right margins.

Handling of Expanded Text in PostScript

Expanded texts are the text contained in such symbols that are mini-
mized1 in a graphical page, see “Text / Additional Heading / Package 
Reference Symbols” on page 1825 in chapter 44, Using the SDL Editor. 

Standard PostScript

Expanded text is output as plain text using the font specified by the 
SDT*PrintFontFamily and SDT*PrintTextHeight preferences. 

Encapsulated PostScript 

Expanded text in EPS output is stored on separate files. One text file is 
generated for each logical page containing expanded text, regardless of 
the number of expanded texts in that logical page. 

• When generating multiple EPS files, the text file for a logical page 
called <x>.eps will be <x>.exp. 

• When printing to one EPS file, the text file for <x> will be <x>.exp. 

PostScript Standard Conformance

The generated PostScript code conforms to either of these standards:

• PostScript Language Document Structuring Conventions - Version 
3.0 

• Encapsulated PostScript File Format - Version 3.0.

FrameMaker Output
FrameMaker output may be generated either as:

• One MIF2 file containing cropped anchored frames
• One or more MIF files containing one logical page each

1. Meaning resized to a minimal size.
2. MIF stands for Maker Interchange Format.
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The generated pages are the same in both cases. A translation table 
is also generated in the latter case.

• One temporary MIF file that can be imported directly into 
FrameMaker. See “Importing into FrameMaker (UNIX only)” on 
page 344.

Depending on the scale setting (see “Scaling in EPS Files” on page 
342), each logical page will be represented as one or more cropped an-
chored frames in the output.

Header, footer and adjacent page markers are not included in the output. 
Paper layout are determined from the Print preferences Frame*Paper-
Format.

Handling of Expanded Text in MIF

Expanded text (see “Handling of Expanded Text in PostScript” on page 
343 for an explanation) is inserted as plain text after the anchored 
frames generated for the corresponding logical page. In order to pre-
serve the appearance of the users original text, hard returns are inserted 
where new lines are found.

MIF Conformance

The generated MIF files conform to FrameMaker Interchange Format 
version 4.00, which can be read into FrameMaker version 4.x, 5.x and 
6.x without problems.

Importing into FrameMaker (UNIX only)

The X Window root window has an atom (property) that governs how 
FrameMaker communicates with Telelogic Tau. The name is arbitrary, 
but must defined both in Telelogic Tau and FrameMaker. In the exam-
ple below, the name _Frame_Tau_Import will be used.

To have Telelogic Tau and FrameMaker behave in accordance, you 
should specify what resource to be used by Telelogic Tau when starting 
FrameMaker. The resource values should be entered in the SDT re-
source file (in which case all users are affected) or in a suitable user X 
resource file. The resource is called sdtfmimp*rpcProp. 
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Example 19: X Resource file sample –––––––––––––––––––––––––––

...
sdtfmimp*rpcProp: _Frame_Tau_Import
...

––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

There are multiple ways to set up FrameMaker. The resource 
Maker.rpcProp may be used for this.

Interleaf Output
Interleaf output may be produced as:

• one IAF1 file containing anchored frames, or
• one or more IAF files containing one logical page each. 

The generated pages are the same in both cases. A translation table is 
also generated in the latter case.

Depending on the scale setting (see “Scaling in EPS Files” on page 
342), each logical page will be represented as one or more anchored 
frames in the output.

Header, footer and adjacent page markers are not included in the output. 
Paper layout are determined from the Print preferences Frame*Paper-
Format.

Handling of Expanded Text in IAF

Expanded text (see “Handling of Expanded Text in PostScript” on page 
343) is inserted as plain text after the frames generated for the corre-
sponding logical page. In order to preserve the appearance of the users 
original text, hard returns are inserted where new lines are found.

IAF Conformance

The generated IAF files conform to Interleaf ASCII Format version 8.0 
(used in Interleaf 5).

MSWPrint Output (Windows only)
The MSWPrint output can be used on Windows to print on any Win-
dows printer, thus this is suitable if the printer does not support Post-

1. IAF stands for Interleaf ASCII Format.
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script. As the complete print output using this option will be divided 
into several print jobs the printing should be done only on one side of 
the paper, otherwise the page numbering will not be as expected.

Handling of Expanded Text in MSWPrint

Expanded text (see “Handling of Expanded Text in PostScript” on page 
343) is handled the same as for standard PostScript.

Microsoft Word Output (Windows only)
Word output can be used to print as a Microsoft Word document. A 
complete Word document is created and the generated pages are created 
as enhanced metafiles. 

Header, footer and adjacent page markers are not included in the output. 
Paper layout are determined from the defaults when creating a new 
Word document.

Handling of Expanded Text in Word output

Expanded text (see “Handling of Expanded Text in PostScript” on page 
343) is inserted as plain text after the frames generated for the corre-
sponding logical page. In order to preserve the appearance of the user’s 
original text, hard returns are inserted where new lines are found.
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Adding Printer Fonts (UNIX only)
By default only three printer fonts are available in printouts: Times, 
Courier and Helvetica. It is possible to add other printer fonts. The re-
quirement is that there exist AFM (Adobe Font Metrics) files for the de-
sired fonts. An AFM file contains the character metrics necessary for 
correct layout of text in printouts.

1. Locate AFM files for the regular, bold, italic and bold italic versions 
of the font. Many AFM files are available from Adobe Systems Inc. 
through on-line services (e.g. via ftp from ftp.adobe.com).

2. Store the files in the directory $telelogic/fontinfo.

3. Name the files according to the scheme in the table below. Note that 
you have to specify <basename> by using lower case characters 
(e.g. palatino-I.afm). Otherwise, you are free to choose any 
<basename> that does not conflict with other fonts or font files.

4. You may then choose the font as <basename> in the Preference 
Manager (case is not important in this context):

The generated files will use the true name of the font, extracted from 
the FontName and FamilyName attributes in the AFM files.

File contents File name

regular font <basename>.afm

bold font <basename>-B.afm

italic font <basename>-I.afm

bold italic font <basename>-BI.afm

Figure 92: Specifying print font as Other.

Palatino is selected in the current example.
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Advanced Print Facilities
This section is divided into three parts.

• The first part lists all advanced print facilities. 
See “List of Advanced Print Facilities” on page 348.

• The second part describes how to use the advanced print facilities to 
produce a nice printout, starting with an SDL system that is not al-
ready prepared for printing with advanced print facilities. 
See “Introducing Advanced Print Facilities” on page 359.

• The third part is about using the advanced print facilities when an 
SDL system is prepared for printing with advanced print facilities. 
See “Using Advanced Print Facilities” on page 373.

List of Advanced Print Facilities
The following print facilities will be described in this section:

• Headers
• Chapters
• Title Page
• State Matrices
• Index
• Fonts
• Text Indentation

Headers

You can create a textual header definition file that defines the appear-
ance of a header that is found at the top of each printed page. All the pos-
sibilities for creating a header is described in “Footer and Header Files” 
on page 335, here you will only find the most important ones.

Figure 93: A header example

HelloWorld      11(12)
Chapter 3 Appendix
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Creating a Header Definition File

The Organizer preference ShowHeader defines if the header symbol 
should be visible as default in the Organizer view. If the header symbol 
is not visible, you can make the symbol visible by selecting Header File 
in the View > View Options dialog.

You can double-click on the header symbol to open a Text Editor to be 
able to define the header and create a header definition file. When you 
have defined the header (read more about some of the possibilities for 
that below), save the file and you are done with this step.

Defining Text in Headers

In the header definition file, insert a line like this:

60 20 This printout was produced by X

This means that 60 millimeters from the left border and 20 millimeters 
from the top border, the text “This printout was produced by X” will be 
placed.

Using Header Variables

In a header definition file, insert a line like this:

100 10 <page>(<totalpages>)

This means that 100 millimeters from the left border and 10 millimeters 
from the top border, a text such as “3(9)” will be placed, informing the 
reader of the printout that this is page three of nine.

Using Pictures in Headers

You can introduce pictures in the headers. The pictures must be in En-
capsulated PostScript file format (EPSF), and they are referenced from 
the header definition file. If you have a picture of for instance your com-
pany logo in a file /home/lat/logo.eps, then you can get it into your 
header with the following line:

EPSF 10 35 /home/lat/logo.eps

This line means that the picture defined in the referenced file will be 
placed 10 millimeters from the left border, and 35 millimeters from the 
top border.

Figure 94: The header symbol in the Organizer view
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Separate First-page Header

You can have one header for the first page, and another header for all 
other pages. To achieve this, you can divide your header definition file 
in three parts by using three different keywords, or rather keylines:

IFFIRST
(Part 1. Place everything that is unique for the 
first page header here.)
ENDIF

IFNOTFIRST
(Part 2. Place everything that is unique for the 
other header here.)
ENDIF

(Part 3. Place everything that is common to both the 
first page header and the other header here.)

Chapters

You can divide the diagrams and documents in your Organizer view 
into different chapters by using the chapter symbol. You add a chapter 
symbol to the Organizer view with Edit > Add New. In the dialog that 
follows, select one of the Chapter alternatives under the Organizer doc-
ument type group, and specify the chapter name under New document 
name. (If you do not want to create a chapter introduction text (see be-
low), make sure that the Show in editor toggle button is off before clos-
ing the dialog.)

Figure 95: Chapters in the Organizer view
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Chapters can be auto-numbered and can be moved with the up and down 
quick buttons. You can select a chapter symbol to restrict the scope for 
diagrams and documents that are going to be printed.

Creating a Chapter Introduction Text

It is possible to associate a text with a chapter symbol. The text will be 
printed at the position of the chapter symbol, and the text can be regard-
ed as a chapter introduction text.

To create a chapter introduction text, you should invoke the Text Editor. 
This can be done in two ways:

• If you have not closed the Add New dialog, then you can bring up 
the Text Editor by making sure the Show in editor toggle button is 
on, before closing the dialog.

• If you have closed the Add New dialog, then you can double-click 
on the chapter symbol. In the dialog that follows, select Edit chapter 
symbol. In the second dialog that follows, make sure that the Show 
in editor toggle button is on and close the dialog to bring up the Text 
Editor.

In the Text Editor, type in the chapter introduction text and save the file.

Starting a New Chapter in the Middle of an SDL Diagram

For a large SDL diagram with many pages, it is convenient to divide the 
different pages of the diagram into different sub chapters. 

To make this possible, you have to make the page symbols visible in the 
Organizer, if they are not visible already. This is done in the View Op-
tions dialog by turning on Page Symbols.

When page symbols are visible, you can move chapter symbols into the 
correct place within the SDL system by using the up and down quick-

Figure 96: Chapters between SDL pages
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buttons. You can also create new chapter symbols directly at the correct 
place, by selecting the SDL symbol that the chapter symbol should be 
placed after, before invoking Add New.

Note that MSCs can be placed in the middle of an SDL system or dia-
gram, in the same way as chapters. This is useful if you want to print an 
MSC close to the corresponding SDL.

Defining the Start Chapter Number

Normally, the start chapter number is 1 (or 1.1 if the first chapter sym-
bol has the type Chapter 1.1.) You can change this number in the View 
> Chapter Options dialog.

Deciding Maximum Chapter Level in the Table of Contents

As default, all chapters are visible in the table of contents. If you have 
a lot of chapters, you can limit the number of chapters in the table of 
contents by using the View > Chapter Options dialog. A maximum 
chapter level of 2 will only include chapter symbols of type Chapter, 
Chapter 1 and Chapter 1.1 in the table of contents.

Printing a Table of Contents with Only Chapters

To print a table of contents, you have to turn on the Table of contents 
toggle button in the Contents section in the Print dialog.

As default, the table of contents includes chapters, diagrams and docu-
ments. To restrict the table of contents to just chapters, there are two 
ways:

• If you want to do a temporary restriction just for one printout, then 
there is a toggle for doing so in a sub dialog to the Print dialog: To 
get to the sub dialog from the Print dialog, press the setup button 
with a picture close to the Table of contents entry in the Contents 
section. In the sub dialog, turn on the toggle Only chapters in TOC.

Figure 97: The Table of Contents entry in the Print dialog
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• If you want the restriction to be more permanent, go to the Prefer-
ence Manager. In that tool, double-click on the Print symbol to ex-
pand its contents, and set the value of the preference OnlyChapters-
InTOC to on. Save the preferences and restart Telelogic Tau.

Title Page

A plain text document can become a title page by placing it first among 
the diagrams and documents that are printed. There is nothing special 
about a title page, except that it can be placed before the table of con-
tents.

Getting the Title Page before the Table of Contents

To print a table of contents, you have to turn on the Table of contents 
toggle button in the Contents section in the Print dialog.

Normally, you do not have to do anything to get the title page before the 
table of contents, because the print operation will as default treat an ini-
tial text document as a title page. There is however a way to turn this on 
and off. This is done in the Print Setup dialog for the Table of contents 
entry in the Contents section in the Print dialog. You can get to this di-
alog from the Print dialog by pressing the setup button with a picture 
close to the Table of contents entry.

Figure 98: Part of the Print Setup dialog for Table of contents

Figure 99: A title text document in the Organizer view
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State Matrices

State Matrices are described in detail in chapter 6, The Text Editor. Here 
are only the most important things discussed, enabling you to get a nice 
printout of state matrices for processes in your SDL system.

Creating State Matrices

When you have a correct SDL system, you can create state matrices 
with the Generate > State Overview menu choice. A state information 
file (*.ins) will be created in your target directory, a plain text symbol 
connected to the file will be added in the Organizer view, and a Text Ed-
itor will pop up, acting as a State Matrix Viewer.

Filter State Matrices

The Text Editor has two menu choices that you can use to get the state 
matrices that you want.

• View > State Matrix > Filter Processes. This menu choice allows 
you to hide state matrices for SDL processes that you are not inter-
ested in.

• View > State Matrix > Transition Information. This menu choice 
decides the information that should be presented for transitions in 
your state matrices. As default, you will get two state matrices for 
each SDL process: One with paper page references to the corre-
sponding SDL transition and one with nextstate information. You 
can with this menu choice also have state matrices with output/sig-
nal sending information and procedure call information.

The options in the two dialogs above can also be set in a more perma-
nent way, using preferences. To do this, use these Text Editor preferenc-
es:

Process HelloWorld: nextstates
States
a Start state
b waiting
c stop
        |  STATES
SIGNALS |  a    b    c
        |-------------
-       |  b
Hello   |       c

Figure 100: A state matrix
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• StateMatrixFilter
• StateMatrixCalls
• StateMatrixNextstates
• StateMatrixOutputs
• StateMatrixPageNumbers

Printing State Matrices with Paper Page References

When you view state matrices on-line, you will not see any paper page 
references in a page number state matrix. All page numbers are unde-
fined and replaced by a “*”. The page numbers are only visible in your 
printout, and only if you print the SDL processes together with the state 
matrices from the Organizer.

Index

The index is described in detail in chapter 47, The SDL Index Viewer. 
Here are only the most important things discussed, enabling you to get 
a nice printout of an index of all SDL entities defined and used in your 
SDL system.

Creating an Index

When you have a correct SDL system, you can press the Generate Index 
quick button in the Organizer. This will pop up an index viewer with an 
index of all SDL entities defined and used in your SDL system.

Filter Index Information

The generated index may be too long to be printed in its entirety. You 
can make the index smaller by filtering out information that you consid-
er unimportant.

Figure 101: An SDL entity index example

c channel in system HelloWorld 5 1 use 6

Hellosignal in system HelloWorld 5 3 uses 5 6 8

HelloWorldblock in system HelloWorld 6

HelloWorldprocess in block HelloWorld 8 2 uses 6 6

sr signalroute in block HelloWorld 6 1 use 6

waitingstate in process HelloWorld 8 1 use 8

Worldsignal in system HelloWorld 5 3 uses 5 6 8
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You can filter out SDL entities defined in specific SDL diagrams. This 
is done with the View > Filter Diagrams dialog. A common use of this 
possibility is to filter out SDL entities defined in package Predefined.

You can filter out SDL entity types. This is done in the View > Filter 
Types dialog. For instance, if you want an index of just the signals in 
your SDL system, then you can use this possibility to filter out all other 
SDL entity types.

To make your filter more permanent than just for the current Index 
Viewer session, you should define your filter settings in the Preference 
Manager before starting the Index Viewer. These two preferences are 
appropriate:

• FilterDiagrams
• FilterTypes

Deciding Index Appearance

Each SDL entity in the index can be presented in four different ways. 
You can change the index appearance for the current Index Viewer ses-
sion with the View > Index Appearance dialog. To make your changes 
more permanent, use the Preference Manager and the following prefer-
ence:

• IndexAppearance

As default, the index appearance is set to Detailed. This setting is ap-
propriate for on-line viewing. For a printout, it might produce unneces-
sary large indexes. To get a smaller index in a printout, use the Compact 
index appearance.

Printing an Index with Paper Page References

It is possible to get paper page references for both definitions and uses 
of SDL entities in a printout of an index. To achieve this, leave the Index 
Viewer window on screen while doing a printout from the Organizer 
that includes your SDL system and the index view.
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Fonts

There are two kinds of fonts:

• Proportional fonts such as Times. These fonts have the advantage of 
not needing much space.

• Non-proportional fonts such as Courier. These fonts have the ad-
vantage of being useful for creating tables where it is important that 
the same character position on different lines are aligned.

Below, you will learn how to set up Telelogic Tau to use appropriate 
fonts for different uses.

Using a Non-Proportional Font in the Text Editor

State matrices are viewed and printed from the Text Editor. State matri-
ces should be presented using a non-proportional font. To get a non-pro-
portional font in printouts of state matrices, set the preference 
SDT*PrintFontFamily to Courier.

Using a Non-Proportional Font for SDL Text Symbols

Sometimes, it is convenient to make aligned tables in SDL text symbols. 
This requires a non-proportional font. On the other hand, you do not 
want a non-proportional font for all other symbols in a process diagram, 
because you want to squeeze as much text as possible into a flow sym-
bol without going outside the symbol border.

You can have a separate, non-proportional font for SDL text symbols. 
This is achieved by setting Editor*FontText*TextSymbolFontFamily to 
Courier. This preference is valid both on-line and in print. All the other 
symbols use the fonts set by Editor*FontText*ScreenFontFamily and 
Editor*FontText*PrintFontFamily.

Title Fonts: Size and Boldness

The table of contents has a title named “Contents” that is always pre-
sented in bold.

Font size and boldness for chapter names in text page titles are deter-
mined by the chapter level:

• Chapter level 1 (for instance 1) uses 14 pt bold.

• Chapter level 2 (for instance 1.1) uses 12 pt bold.
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• Chapter level 3 (for instance 1.1.1) uses 11 pt bold.

• Chapter level 4 (for instance 1.1.1.1) uses 11 pt, not bold.

A normal text, and a chapter without a chapter number (chapter level 0), 
uses the same font appearance for the title as the font used for the fol-
lowing text.

To get header titles in a larger font (14 pt) and with a bold text, use a 
header definition file with a Title keyword. (<#Title>, <#Title 2> or 
something similar.)

Text Indentation

There are three text indentation levels, and each text indentation level 
has a corresponding preference:

• Print*TextIndentation1. Used by text pages for presenting chapter 
numbers. Default: 44 mm from the left paper edge.

• Print*TextIndentation2. Used by text pages for presenting chapter 
names and normal text. Also used by the table of contents for pre-
senting chapter numbers. Default: 67 mm from the left paper edge.

• Print*TextIndentation3. Used by the table of contents for presenting 
chapter names. Default: 90 mm from the left paper edge.
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Introducing Advanced Print Facilities
In this sub section we will take a more detailed and practical look at how 
an ordinary SDL system can be turned into an SDL system with en-
hanced print facilities.

Initial Setup

Before starting doing print enhancements for the specific SDL system, 
we should set up some preferences affecting how the final printout will 
look like.

1. Bring up the Preference Manager with the menu choice Tools > 
Preference Manager.

– To get a non-proportional font in printouts of state matrices, set 
the preference SDT*PrintFontFamily to Courier.

– To get a non-proportional font in text symbols in SDL diagrams, 
set the preference (SDL) Editor*FontText*TextSymbolFont-
Family to Courier.

2. Save the preferences and exit the Preference Manager.

The Example SDL System

We will use an SDL system called HelloWorld as an example. When we 
start, we have a correct SDL system that is not adapted in any way for 
producing a nice printout. If we just do a plain printout of HelloWorld, 
we will get the following:

Note: 

As default in this section, we are talking about menu choices and di-
alogs in the Organizer.

Note: 

The figures below are not exact copies of a printout, they have been 
modified slightly to fit in this manual.
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Figure 102: HelloWorld, Organizer view

Figure 103: HelloWorld, system diagram

Figure 104: HelloWorld, block diagram

SDT rw /home/lat/hello/originalHW.sdt

rw /home/lat/hello/

HelloWorld rw HelloWorld.spr

HelloWorld rw HelloWorld.sbk

HelloWorld rw HelloWorld.ssy

System HelloWorld 1(1)
SIGNAL
Hello,
World;

HelloWorld
c

World Hello

Block HelloWorld 1(1)

HelloWorld

sr

World Hello
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To get a better printout, we will add the following:

• A Header on Each Printed Page
• A Title Page
• Chapters and Sub Chapters
• State Matrices for the SDL Process
• An Index of SDL Entities

When we have done that, we will perform a print operation to actually 
get our enhanced printout.

A Header on Each Printed Page

The header should have the following properties:

• A separate header appearance for the first page.
• The company logo should be visible on every page.
• The header should include information about page number, total 

pages, chapter number and chapter name.

Fortunately, someone at our company has provided a company logo in 
Encapsulated PostScript format (*.eps), and a template header defini-
tion file. The template looks like this:

Figure 105: HelloWorld, process diagram

Process HelloWorld 1(2)

waiting

Hello

World

Process HelloWorld 2(2)

/* This page will be used for future extensions */
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IFFIRST
18 28 Name of designer
ENDIF

IFNOTFIRST
183 20 <page>(<totalpages>)
90 24 Chapter <chapternumber> <chaptername>
ENDIF

EPSF 10 25 /home/lat/hello/telelogic.eps
90 20 Name of SDL system

Action

1. The header symbol is not visible in the Organizer view. To make it 
visible, bring up the View Options dialog and select the Header file 
item and press Apply and Close.

2. To create a new and unique header for the SDL system, double-click 
on the header symbol in the Organizer view. 

3. In the Edit dialog that follows, we should specify the template file 
under Copy existing file. In our case, someone has put the template 
file in /home/lat/hello/headerTemplate.txt.

4. When we close the Edit dialog, the text editor pops up with a copy 
of the template header file. 

5. To get a unique header for our SDL system, we change the follow-
ing things:

Name of designer -> Lars Tufvesson
Name of SDL system -> HelloWorld

6. When that is done, we save our specialized header file in the same 
directory as our SDL diagrams.

Figure 106: Specifying the template header file in the Add New dialog
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A Title Page

A title page is a plain text document that is placed first among all printed 
pages and documents.

Action

1. We should add a new plain text document to our SDL system. To 
make sure it is placed first, select the header symbol before invoking 
Add New. 

2. In the Add New dialog, set the document type to Plain Text and set 
the document name to TitlePage.

3. When you close the dialog, the Text Editor pops up. Type in an ap-
propriate title page text (like the one below) and save the text file in 
the same directory as the SDL diagrams.

   *******************
   *System HelloWorld*
   *******************

A revolutionary SDL system software package

Chapters and Sub Chapters

We would like to divide our diagrams and documents in three chapters:

• The first chapter contains state matrices for the SDL process(es).
• The second chapter contains the SDL system.
• The third chapter is an appendix that contains the index of SDL en-

tities.

The second chapter will be further divided into two sub chapters. Each 
chapter and sub chapter should have a chapter introduction text.

Action

1. We would like to place the first chapter directly after the title page 
text symbol. Select the title page text symbol and bring up the Add 
New dialog. 

2. Set the document type to Organizer > Chapter 1, and the document 
name to State Matrices. 

3. When you close the dialog, the Text Editor will pop up. Type in an 
appropriate chapter introduction text (like the one below) and save 
the text file.
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This chapter contains two state matrices for the
SDL process: One with page numbers to the SDL
process and one with nextstate information.

We will produce the state matrices for this chapter in the next sub sec-
tion. For now, we leave this chapter empty.

4. We introduce a second chapter for the SDL system. Select the State 
Matrices chapter symbol and bring up the Add New dialog. Set the 
document type to Organizer > Chapter 1, and the document name 
to SDL system. When you close the dialog, the Text Editor will pop 
up. Type in an appropriate chapter introduction text (like the one be-
low) and save the text file.

In this chapter, you will find the actual SDL 
system.

5. The SDL system chapter should have two sub chapters for the SDL 
process. To be able to begin a chapter between two pages in one 
SDL diagram, we must make page symbols visible in the Organizer. 
This is done in the View Options dialog by selecting Page symbols 
and pressing Apply and Close.

6. The first sub chapter should begin where the process diagram be-
gins. Select the process diagram symbol and bring up the Add New 
dialog. Set the diagram type to Organizer > Chapter 1.1, and the 
document name to First process page. When you close the dialog, 
the Text Editor will pop up. Type in an appropriate chapter intro-
duction text (like the one below) and save the text file.

In this sub chapter, the first process page will be 
defined.

7. The second sub chapter should be placed between the two pages of 
the SDL process. Select the first process page symbol and bring up 
the Add New dialog. Set the diagram type to Organizer > Chapter 
1.1, and the document name to Second process page. When you 
close the dialog, the Text Editor will pop up. Type in an appropriate 
chapter introduction text (like the one below) and save the text file.

In this sub chapter, the second process page will be 
defined.

8. Finally, we should have an appendix chapter for the index of SDL 
entities. This chapter should be placed last in the Organizer view. 
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Select the last symbol in the Organizer and bring up the Add New 
dialog. Set the diagram type to Organizer > Chapter 1, and the doc-
ument name to Appendix. When you close the dialog, the Text Edi-
tor pops up. Type in an appropriate chapter introduction text (like 
the one below) and save the text file.

The appendix contains an index of all SDL entities.

State Matrices for the SDL Process

The Organizer can with the help of the Analyzer generate a state over-
view information file (*.ins). The file is placed in the target directory. 
The Text Editor can display this file as state matrices.

Action

1. First, we should set the target directory to an appropriate directory 
where we can allow Telelogic Tau to create files. Bring up the Set 
Directories dialog and type in an appropriate target directory. When 
that is done, close the dialog.

2. Select the SDL system diagram and invoke the state overview infor-
mation file generation with Generate > State Overview. The Ana-
lyzer will check your SDL system and produce some files in the tar-
get directory. One of these files is the *.ins file. 

3. When the Analyzer is ready, the Text Editor will pop up, showing 
you the state matrices created from the information in the state over-
view file (*.ins). When you have examined the state matrices, exit 
the Text Editor.

4. The plain text symbol connected to the *.ins file should be placed 
in the first chapter instead of in the same chapter as the SDL system. 
To move the plain text symbol for the *.ins file to the correct lo-
cation, select the symbol and use the up quick button as many times 
as required to get the symbol into the first chapter.

An Index of SDL Entities

We would like an index of SDL entities defined in our SDL system last 
in the printout. The Organizer can with the help of the Analyzer produce 
a cross reference file. The Index Viewer can present the information in 
the cross reference file as an index. To keep the size of the index small, 
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we filter out some SDL entities and we present the index in an as com-
pact way as possible.

Action

1. Make sure that the target directory is set to an appropriate directory 
where the Analyzer can create some files.

2. Select the SDL system diagram symbol and press the Generate In-
dex quick button. The Analyzer will check your SDL system and 
generate some files in the target directory. One of the files is named 
*.xrf and contains the cross reference information. The Index 
Viewer pops up when the Analyzer is ready, and presents the cross 
reference information as an index.

3. If you examine the index, you will notice that there are a lot of SDL 
entities defined in package Predefined. Let us assume that we are 
not interested in these SDL entities. To get rid of them, we bring up 
the Filter Diagrams dialog and select package Predefined. When 
the dialog is closed, our Index will be much smaller.

4. To get an even smaller index, bring up the Index Options dialog and 
set the index appearance to Compact.

5. Now, the index is ready for printing. Since there is no symbol in the 
Organizer view for the cross reference file, we have to leave the In-
dex Viewer window open until we have completed the print opera-
tion.

Performing the Print Operation

Now, everything is in place to do the actual print operation. 

Action

1. Make sure you have no selection in the Organizer. This can be done 
by clicking somewhere outside a symbol or text line. This is done to 
tell the Organizer that we want to print everything, and not just what 
we have selected.

2. Bring up the Print dialog.
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3. Make sure that the following entries in the Contents area are select-
ed:

– Table of contents
– Organizer View
– SDL Interaction
– Text Diagram
– Index View

No other entries in the Contents area should be selected.

4. Bring up the Table of contents setup dialog with the picture button 
close to the Table of contents entry. In the setup dialog, make sure 
that both After initial text document and Only chapters in TOC are 
both selected. Close the setup dialog.

5. Make sure that the header file check button is on.

6. Make sure that the settings in the Destination area are appropriate.

7. Click the Print button. We will get a printout, looking approximate-
ly as the figures below.

Figure 107: The title page

Figure 108: The table of contents

Lars Tufvesson

HelloWorld

*******************
*System HelloWorld*
*******************
A revolutionary SDL system software package

HelloWorld       ii(12) 

Contents

1    State Matrices.....................2
2    SDL System.........................4
2.1  First process page.................7
2.2  Second process page................9
3    Appendix..........................11

Chapter
July 2003 Telelogic Tau 4.5 User’s Manual ,um-st1 367



Chapter 5 Printing Documents and Diagrams 
Figure 109: The Organizer view

Figure 110: The introduction to chapter 1

SDT rw /home/lat/hello/currentHW.sdt

rw /home/lat/hello/

rw currentHeader.txt

TitlePage rw TitlePage.txt

1  State Matrices rw StateMatrices.txt

HelloWorld rw HelloWorld.ins

2  SDL system rw SDLSystem.txt

1

1

2.1  First process pagerw FirstProcessPage.t
1
2.2  Second process pagerw SecondProcessPage.
2

HelloWorld rw HelloWorld.spr

HelloWorld rw HelloWorld.sbk

HelloWorld 7 HelloWorld.ssy

3  Appendix rw Appendix.txt

HelloWorld      1(12)
Chapter

HelloWorld      2(12)
Chapter 1 State Matrices

This chapter contains two state matrices for the
SDL process: One with page numbers to the SDL
process and one with nextstate information.
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Process HelloWorld: page numbers
States
a Start state
b waiting
c stop
        |  STATES
SIGNALS |  a    b    c
        |-------------
-       |  8
Hello   |       8

Process HelloWorld: nextstates
States
a Start state
b waiting
c stop
        |  STATES
SIGNALS |  a    b    c
        |-------------
-       |  b
Hello   |       c

Figure 111: The state matrices

Figure 112: The introduction to chapter 2

HelloWorld      3(12)
Chapter 1 State Matrices

HelloWorld      4(12)
Chapter 2 SDL System

In this chapter, you will find the actual SDL system.
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Figure 113: The SDL system diagram

Figure 114: The SDL block diagram

Figure 115: The introduction to chapter 2.1

System HelloWorld 1(1)
SIGNAL
Hello,
World;

HelloWorld
c

World Hello

HelloWorld      5(12)
Chapter 2 SDL System

Block HelloWorld 1(1)

HelloWorld

sr

World Hello

HelloWorld      6(12)
Chapter 2 SDL System

HelloWorld      7(12)
Chapter 2.1 First process page

This sub chapter contains the first part of the SDL
process
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Figure 116: The first process page

Figure 117: The introduction to chapter 2.2

Process HelloWorld 1(2)

waiting

Hello

World

HelloWorld      8(12)
Chapter 2.1 First process page

HelloWorld      9(12)
Chapter 2.2 Second process page

This sub chapter contains the second part of the SDL
process
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Figure 118: The second process page

Figure 119: The introduction to the appendix

Figure 120: The index

Process HelloWorld 2(2)

/* This page will be used for future extensions */

HelloWorld      10(12)
Chapter 2.2 Second process page

HelloWorld      11(12)
Chapter 3 Appendix

The appendix contains an index of all SDL entities.

/home/lat/target/HelloWorld.xrf

c channel in system HelloWorld 5 1 use 6

Hellosignal in system HelloWorld 5 3 uses 5 6 8

HelloWorldblock in system HelloWorld 6
HelloWorldprocess in block HelloWorld 8 2 uses 6 6

sr signalroute in block HelloWorld 6 1 use 6

waitingstate in process HelloWorld 8 1 use 8

Worldsignal in system HelloWorld 5 3 uses 5 6 8

HelloWorld      12(12)
Chapter 3 Appendix
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Using Advanced Print Facilities
In the previous section, we took an ordinary SDL system and made en-
hancements to get a nice printout. In this section, we will look at how 
we can make the enhancements as permanent as possible. We would 
like to be able to load a system file, invoke the print operation and get a 
nice printout without changing any print settings.

Let us take a new look at all the changes we have made, to see how we 
can make a future print operation as painless as possible.

A Permanent Title Page

Every time the print dialog is invoked, the Table of contents setup op-
tion After initial text document will be turned on. This means that the 
title page will show up as a title page in future print operations also. No 
extra actions necessary here.

Permanent Chapters and Sub Chapters

The chapter symbols should stay where they were initially placed. Due 
to implementation reasons, chapter symbols placed between SDL page 
symbols might be a little more volatile than they should be. The position 
of a chapter symbol is determined by remembering the name of the next 
SDL page symbol. If you rename that SDL page symbol, the chapter 
looses its hook and may end up in the wrong position.

The chapter options that you can set in the Chapter Options dialog are 
reset every time Telelogic Tau is restarted. This means that if you want 
the start chapter number to permanently be anything other than 1.1.1.1, 
or you want to hide sub chapters in the table of contents, then you have 
to check the Chapter Options settings before each print operation.

Permanent State Matrices

State matrix options are not saved together with the state overview file 
(*.ins), but they are saved in the system file (*.sdt) and in print selec-
tion files (*.sel).

The state overview file (*.ins) is generated in the target directory. You 
may regard the target directory as a temporary directory where files can 
be erased after a Telelogic Tau session is ended. It might be cumber-
some to regenerate a state overview file each time you want to do a 
printout. In this situation, it might be a good idea to move the state over-
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view file to the source directory, where your SDL diagram files resides. 
The file move is most easily done outside of Telelogic Tau, but you 
have to reconnect the plain text symbol in the Organizer view to the 
state overview file in the source directory with Telelogic Tau.

A Permanent Index

Index options are not saved together with the cross reference file (*.xrf), 
but they are saved in the system file (*.sdt) and in print selection files 
(*.sel).

The cross reference file (*.xrf) is generated in the target directory. 
You may regard the target directory as a temporary directory where files 
can be erased after a Telelogic Tau session is ended. It might be cum-
bersome to regenerate a cross reference file each time you want to do a 
printout. In this situation, it might be a good idea to move the cross ref-
erence file to the source directory, where your SDL diagram files re-
sides. The file move is most easily done outside of Telelogic Tau.

To get paper page references in the index, the index has to be printed 
from the Organizer together with the SDL system.

Performing a Permanent Print Operation

Every time the print dialog is invoked, the Table of contents setup op-
tion Only chapters in TOC will be set to off. This means that if you want 
only chapters in the table of contents, you have to turn this option on ev-
ery time you want to print.

In a similar manner, every time Telelogic Tau is started, the Table of 
contents toggle button in the main print dialog is set to off. This means 
that every time you want to do a print, you have to check the Table of 
contents toggle button and turn it on, if it is off.

Print Selection Files and Print Selection Symbols

Most print, index and cross reference options are saved in the system 
file (*.sdt). This is often enough for most of your print needs. However, 
in some situations you might want to save more than one set of print set-
tings: You want to easily switch...

• Header and footer information
• The set of documents/diagrams/pages that should be printed.
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This can be done by saving a couple of print selection files with differ-
ent print settings, and reference these files with print selection symbols 
in the Organizer.

1. To save print settings in a print selection file, bring up the Organizer 
print dialog, as you would for performing a normal print operation. 

2. Adjust the settings in the dialog to what you want printed, both by 
changing what diagrams to print and by changing how the print will 
be performed (paper format etc.). 

3. When all settings are correct, use the Save button to save the print 
selection file. In the dialog that appears, you can both decide the 
print selection file name to use, and if a print selection symbol 
should be created in the Organizer or not.

A print selection can be reused in several ways:

• Double-click the print selection symbol.
• Select the print selection symbol and invoke File > Print > Selected.
• Invoke File > Print > Selection File, and specify the print selection 

file in the dialog that appears.

In all these cases, the Organizer print dialog will appear, with settings 
according to the reused print selection file.
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